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arthropods
insects and their relatives
PowerPoint Notes




This presentation can be used as an introduction to a unit on arthropods or as a unit supplement on arthropods.  Although the presentation has been designed for an adult audience, you can change the text or the format of the presentation as necessary to adapt the presentation for your students.

Using this script, you can present this PowerPoint for your students, or have students work together to present the PowerPoint to the rest of the class. The presentation will take approximately 30 minutes.

The images included in this PowerPoint are intended for use as a part of this presentation only.  You may print handouts of this PowerPoint to distribute to your students. The images in this presentation may not be reproduced in any way or used in another publication (other than student handouts) without written permission from the owners of the images.  See Slides 21-23 of the PowerPoint for image credits.

View show: To run the PowerPoint presentation, first go to the Slide Show menu and then click on From Beginning.

Hide slides: To hide specific slides so that they are not displayed when you run the PowerPoint presentation, first go to the “slide sorter” view by clicking on Slide Sorter under the View menu.  Select the slide you wish to hide by clicking on it.  Then, from the Slide Show menu, click on Hide Slide. 

Print a handout master: To print a handout master to accompany the presentation, click on Print under the File menu. Rather than Full Page Slides, choose Handouts – 6 Slides Horizontal or Handouts - 3 slides.  Handouts with three slides per page provide students with lines to the right of each slide to take notes, but handouts with six slides per page use less paper

Adapt text: To change existing text, highlight the text you wish to change and type in your changes. To insert a new text box, go to “Insert” on the main tool bar and click on “text box.”  Then use the mouse to select the area on the slide where you would like to insert the text.  Once you select the area, type in the information you would like to add.

Save your changes: Note that you will need to save altered presentations to a hard drive or burn them to a disk for future use.
Arthropods: Insects and their relatives
Slide 1: Arthropods: Insects and their relatives
Slide 2: Arthropods: Insects and their relatives
· This presentation will cover some basic information about arthropods and will introduce some of the relationships between humans and arthropods.

· The classification of arthropods (phylum Arthropoda) is somewhat complex and varies according to different sources. For this presentation we will consider five major groups of arthropods: arachnids, crustaceans, millipedes (Diplopoda), centipedes (Chilopoda) and insects. 

· (See text on slide)

Slide 3: Characteristics of phylum Arthropoda
· (See text on slide.)

· The exoskeletons of arthropods are made up of a calcium-containing compound called chitin –exoskeletons cannot expand so arthropods must molt in order to grow. The banana slug in this photograph does not have an exoskeleton, but the millipede does. (Slugs are mollusks, phylum Mollusca).

Photo: banana slug and cyanide-producing millipede (temperate forest floor, WA)

Slide 4: Arthropod Anatomy
· (See text on slide).
Photo: thatch ants (temperate forest floor, WA; ovipositor of New Guinea walking stick (WPZ)

Slide 5: Five major classes of Arthropods
1) Arachnida

· (See text on slide.)

· The number of species listed here for each group of arthropods refers to the number of species identified to date; each group of arthropods includes species that have yet to be discovered and identified.

· Most arachnids have two body regions – the cephalothorax (fused head and thorax) and the abdomen; some arachnids, however, have only one body region (fused cephalothorax and abdomen). The majority of adult arthropods do not molt; tarantulas, however, are an exception. Adult tarantulas can live up to 30 years, over which time their exoskeleton and hairs wear out and need to be replaced through molting.

Photos: (left to right) - emperor scorpion (WPZ), mite (WPZ), Chilean rose tarantula (WPZ), Christmas spider (temperate forest, Australia)

Slide 6: Spiders of the Puget Sound Region
· (See text on slide.)

Slide 7: Five major classes of Arthropods
2) Crustacea

· (See text on slide.)

· Crustaceans are the most morphologically diverse group of arthropods, meaning that the form and structure of each species of crustacean can differ greatly from that of other species, although all the species share the general characteristics listed here (on the slide).

Photos: sowbug (WPZ), barnacles (beach, South Puget Sound, Washington), crab (beach, southwest Australia)
Slide 8: Five major classes of Arthropods
3) Diplopoda

· (See text on slide.)

· Millipedes are scavengers, eating a variety of decaying organic matter, mainly from plants.

Photos: giant African millipede (WPZ), millipede (temperate forest, WA)
Slide 9: Five major classes of Arthropods
4) Chilopoda 
· (See text on slide.)

· Centipedes are carnivorous and use a modified pair of legs to inject venom into their prey.  Millipedes and centipedes are sometimes grouped together into a class called “myriapods”.

Photo: giant centipede (WPZ)

Slide 10: Five major classes of Arthropods
5) Insecta

· (See text on slide.)

· The word “bug” is often used loosely to mean all insects, or even all arthropods. However, true bugs are one order of insects, the Hemiptera, which includes stink bugs and assassin bugs.

Photos: syrphid fly (WPZ grounds), tiger beetle (Japan), crane fly (WPZ grounds), butterflies (WPZ), Peruvian firestick (WPZ)

Slide 11: Arthropod Taxonomy
· (See text on slide.)

Photos: honeybees (WPZ) and millipede (temperate forest, WA)

Slide 12: Arthropod Development
· (See text on slide.)
· In the larval stage of most arthropods, the exoskeleton may not be fully developed. Wings and reproductive organs are not fully formed until arthropods reach the adult stage of their life cycle. As adults most arthropods do not molt – tarantulas are an exception.

Slide 13: Arthropod Diversity and Abundance
· (See text on slide.)
· As scientists investigate arthropods in different ecosystems around the world, estimates of their diversity and abundance change continually. The numbers here refer to known species of insects and other animals and are extrapolated from field research – the truth is we will probably never really know how many species of insects and other arthropods there are. There are many habitats that have not yet been fully explored and there will most likely always be more arthropods out there than we know about!

· The chart shows how arthropods and other invertebrates contribute to the biomass (mass of living things) of the Earth in comparison to the biomass of other animal groups.

Photos: spider (beach, southwest Australia), carabid beetle (temperate forest, WA), goliath walking stick (Healesville Sanctuary, Australia), velvet mite (temperate forest, WA), ant and aphids (shrub-steppe, eastern WA). Chart adapted from E. O. Wilson (graphic from “Bug” World, WPZ).
Slide 14: Arthropod Diversity and Abundance
· Why are arthropods such a diverse group? (See text on slide.)
· Beetles are the most diverse group within insects – approximately 40% (close to 400,000 species) of insects are beetles (therefore, approximately 25% of all animal species are beetles, and there are 100 times more species of beetles that have been identified than mammals!)

Photos: flamboyant flower beetle (WPZ), giant water bug (WPZ), tiger beetle (Japan), darkling beetle (shrub-steppe, eastern WA)
Slide 15: Roles of arthropods in ecosystems: benefits for humans
· (See text on slide.)

· The following are some additional examples of how arthropods benefit humans:

· Forensic entomology – detective work based on insect life cycles and their roles in  decomposition. For example, scientists could determine the time of death of a corpse based on the life stages of the arthropods on the body.

· Plant protection – some nectar-feeding insects will protect nectar-producing plants from other insects that could damage the plants

· During the siege by the Duke of Lorraine against King Henry I of France in the 11th century, beehives were tossed among the Duke's troops. The bees panicked the horses and led to the rapid retreat of the Duke’s troops.

· Extra protein – according to the national Food Defect Action Levels (levels of natural or unavoidable defects in food that present no health hazards for humans) frozen broccoli can have an average of 60 or more aphids and/or thrips and/or mites per 100 grams. (Food Defect Action Levels: http://www.fda.gov/Food/GuidanceRegulation/GuidanceDocumentsRegulatoryInformation/SanitationTransportation/ucm056174.htm).

Photos: millipede (temperate forest, WA), bumblebee (temperate forest, WA), leaf-rolling spider (temperate forest, southeastern Australia), ladybug (WPZ grounds)
Slide 16: Roles of arthropods in ecosystems: fun facts
· (See text on slide.)

· These facts are found on flaps in the zoo’s “Bug” World building.

Slide 17: Bugs rule! Threats to humans
· (See text on slide.)

· It is important to point out that only 1% of all known insect species negatively impact humans, however insects and other arthropods do have significant impacts on our lives and health. The following are additional examples of how arthropods have impacted humans:

· The bubonic plague had a huge impact on human populations – in the 1300s, 25 million people died in Europe due to the plague. Bubonic plague is spread by fleas from infected rats.

· Africanized bees are a subspecies of honeybee, they are morphologically the same as honeybees, but behave differently. Africanized bees are more easily disturbed, will abandon their nest more readily and will sting more readily. Africanized honeybees produce more than twice as much honey as common honeybees in the US and were purposely brought from Africa to Brazil, but were accidentally released into the wild in 1957 and have been spreading northward since.

· Malaria is one of the most prevalent of human infectious diseases and kills more people than any other communicable disease apart from tuberculosis. Four species of protozoa (single-celled parasites) are responsible for malaria and are all transmitted by Anopheles mosquitoes. There are estimated between 1 million and 1.5 million deaths each year due to malaria. Candidate vaccines are currently in development and several are under clinical trial, with the hope that a vaccine can be available in 5-15 years.

· Termite damage in New Orleans has significantly impacted residential and historical structures in the city. Formosan termites from southeast Asia were accidentally introduced to the United States in the mid-1960s. In New Orleans, the average homeowner spends several thousands of dollars each year on termite control and damage repair.

Photos:  beetle larvae tunnels (temperate forest, WA), giant centipede (WPZ), dampwood termite (WPZ)

Slide 18: Cultural Entomology: insects in human culture
· (See text on slide.)

· The following are some additional topics to explore and/or discuss relating to insects in human culture:

· Japan - aesthetic appreciation of insects in literature, art and recreation

· Literature - positive and negative portrayals (e.g. Charlotte's Web)

· Figures of speech (e.g. “Quit bugging me!”)

· Film - positive and negative/ realistic vs unrealistic (e.g. Arachnophobia)

· Music and performing arts

· Graphic arts

· Historical - influence of silk trade in Chinese empire

· Religious significance: 

· Aztecs - butterfly goddess

· Greek - Artemis bee goddess

· Chinese - insect lord over crop pests

· Babylonians - scorpion men

· Hopi - personify insect spirits - butterfly man, assassin fly - in the form of Kachina dolls

· Bushman - mantis is god of creation

Photos:  dung beetle (Melbourne Zoo grounds, Australia), mealworm pupa (WPZ)

Slide 19: Appreciation and Conservation
· (See text on slide.)

Photos:  Bug Club members in 2000 and in 2012, WPZ
Slide 20: Appreciation and Conservation
· (See text on slide.)

Photo:  fruit stamp art by WPZ Bug Club member
Slide 21: Credits

· (See text on slide.)

Slide 22: Photos
· (See text on slide.)

Slide 23: Photos
· (See text on slide.)
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		January 1, 2011



		to:

		All CA Employees



		from:

		Creative Services



		re:

		Training for new CA Technologies templates





This document provides an introduction to and training for your new templates. It includes an overview of CA Technologies styles as well as a primer on using styles.

I. An Overview of CA Technologies Styles

The styles used in this sample memo are included in a pull-down style menu in the formatting toolbar and/or the formatting palette. Using this pre-set formatting will save you time and effort and ensures that your documents are consistent with all CA Technologies communications. 

(Please note: this document template contains more styles than referenced in this sample. All styles for both letters and memos are in all templates. For simplicity, this document introduces the more standard styles for reports and other memoranda. An accompanying sample letter references styles more appropriate to standard correspondence.)

We use different formatting elements within a document, such as headings, body text, bullet text, etc., to help our audience better understand our communications. The most common elements are included in our style menu, so simply highlighting a section of text and selecting the appropriate style will result in a consistent usage and look throughout.

Using this memo as an example, you would begin with the Date, followed by a table pre-formatted with rows to accommodate to, from and re. The first column of fields has pre-set text, followed by the second column, which contains live text in Address style: Calibri 11 points. The table is set to “wrap text” with appropriate margins and spacing to accommodate additional lines, if needed.

To acquaint you with the most commonly used formats used in CA documents, the next two pages of present samples of styles. The first page details styles established for body text many variations, including bulleted and numbered lists. Following it is a page that exemplifies headings, presented in combination with paragraphs of body text so you might see the hierarchy of available headings.

Body Text style: The font is Calibri 11 points with line spacing set at 1.4 lines. Set text to align left, never justify. Consistent use of this format will help provide a positive, coherent image, as well as further advance the visual appeal of our stationery system. 

List Bullet style: Font size and line spacing duplicate Body Text style, with no space before and only 5 pt space after to help bulleted items group together. 

List Continue style: Font size and line spacing duplicate Body Text style, with no space before and some space after to help bulleted items group together. 

List Bullet 2 style: Font size and line space duplicate Body Text style, with no space before and only 5 pt space after to help bulleted items group together. From the standard document margins, the left margin is indented an additional .5 inches. Hanging indent is set at .25 inches to accommodate the em-dash set in the normal font. 

List Continue 2 style: Font size and line space duplicate Body Text style, with no space before and some space after to help bulleted items group together. 

List Bullet 3 style: This memo demonstrates the typing format for all correspondence.

List Continue 3 style: Font size and line space duplicate Body Text style. 

List Bullet 4 style: Please note: this style is not commonly used. Hanging indent is set at .25 inches to accommodate the en-dash set in the normal font.

List Continue 4 style: Font size and line space duplicate Body Text style. 

List Bullet 5 style: Please note: this style is not commonly used. Hanging indent is set at .25 inches to accommodate the en-dash set in the normal font.

List Continue 5 style: Font size and line space duplicate Body Text style. 

List Number style: Font size and line spacing duplicate Body Text style. Hanging indent is set at .25 inches to match bullet lists; numeral is set in the default font.


Content on this page exemplifies headings, presented in combination with paragraphs of body text so you might see the hierarchy of available headings. While there is no rule that all heading styles must be used in every document, you should plan to use them systematically, as emphasis set through boldness and spacing is reduced with each level of heading. With the exception of this sample page, this document only uses Heading 1 and Heading 2. 

Header 1 Style: Calibri Bold ALL CAPS 11 Points; 20 PTs Before, 5 PTS After

This document demonstrates the format for all correspondence on our letterhead. Consistent use of this format will help provide a positive, coherent image, as well as further advance the visual appeal of our stationery system.

Header 2 style: Calibri 11 points bold; 15 points space before, 5 points after

This document demonstrates the format for all correspondence on our letterhead. Consistent use of this format will help provide a positive, coherent image, as well as further advance the visual appeal of our stationery system.

Header 3 Style: Calibri 11 points ALL CAPS; 10 points space before, 5 POINTS AFTER

This document demonstrates the format for all correspondence on our letterhead. Consistent use of this format will help provide a positive, coherent image, as well as further advance the visual appeal of our stationery system.

Header 4 style: Calibri Bold 11 points; 10 points space before, no space after

This document demonstrates the format for all correspondence on our letterhead. Consistent use of this format will help provide a positive, coherent image, as well as further advance the visual appeal of our stationery system.

Heading 5 style: Calibri Italic 11 points; 5 points space before, no space after

This document demonstrates the format for all correspondence on our letterhead. Consistent use of this format will help provide a positive, coherent image, as well as further advance the visual appeal of our stationery system.


II. A Primer on Using Styles

 (
Figure 1— 
Styles window
)[image: ]Within a document, we use formatting differences — such 
as headings, subheadings, 
body text, bullet text, etc. — 
to guide our audience through the information to help our readers better understand. 

IN OFFICE 2007, when you open 
one of your template documents, you may need to open the Styles window (See Figure 1).

NEW IN OFFICE 2007  
Alt + Control + Shift + S 
opens the Styles window

Always formatting documents with only CA styles will result in a consistent usage and look companywide. Simply highlighting a section of text then clicking one of the styles in the toolbar applies that style. 

What is a style?

A style is a set of formatting characteristics that you can apply to text in your document to quickly change attributes. When you apply a style, you apply a predefined set of formats in one simple step.

For example, the “Address” style we use has our standard line spacing, while the “Date” style has extra space before and after it to set it apart. Rather than remembering the spacing specifics, we have created a separate style for this formatting option. Some of the style types available in Word 2007 include paragraph, character, linked (paragraph and character), table and list.


A trick to using paragraph styles

Most styles you will be using are paragraph-based, meaning they only work if the entire paragraph is selected. To accurately apply them, you must make sure to select all lines, including the sometimes-hidden paragraph symbol (¶) that’s created when you use the return key (See Figure 2).

 (
Figure 
2
 — 
A
 document with hidden characters shown
)[image: ]If after selecting a series of lines the styles don’t seem to work, perhaps you have not highlighted the paragraph completely… remember that spaces,                  tabs			 or shift-returns
do not truly end a paragraph.

To show nonprinting characters:

NEW IN OFFICE 2007  [Control + Shift + 8] toggles Show/Hide on and off, allowing you to view or not view paragraph and other invisible formatting marks.

 (
Figure 3 — Show/Hide nonprinting characters button on the standard toolbar in Office 2003
)[image: ]On the Home tab in the paragraph area, toggling the Show/Hide button turns invisible characters off and on — it is the one with a paragraph (¶) symbol (See Figure 3).  
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